Data, Information and Database
Data is a recognizable graphic figure or symbol that may be a number, letter, or special letter. A single symbol is known as a character. Information is obtained by organizing data so that they are associated with meaning. There are four basic types digital information: text, graphic, audio and video. When two or more characters are meaningfully combined, text information is formed. Graphics are painted, drawn or photographic images. They can be created as digital images or converted to digital images by be scanning. Audio is sound pressure variation in an elastic medium with a frequency range of 2 to 20 kHz. Video is animated graphics with or without sounds. In animation, a time dimension is added to 2D or 3D images with or without sound. Graphics are inherently information objects because drawings, paintings and pictures have meaning associated with them at creation. The clarity and legibility of text information is greatly enhanced by graphic elements. When sound is added to graphic and text information, greater impact and retention is achieved. Video makes graphic and sound information come alive because moving images create greater impressions on the human mind.

A database is a collection of data and information about items of interest. Modern databases are electronic. That means data and information are stored in electronic media. The main advantages of databases are that 1) data is structured and well organized; 2) data can be entered, modified, and stored safely; 3) authorized users can have access to the same data and information content; 4) centralized management of data is possible; 5) data redundancy or duplication is minimized; 6) data and information can be integrated from different databases; 7) there is more effective use of resources. A selected set of data for a specific purpose creates a view from the database. The view could be modified or turned into a report. Different types of report can be generated from the same database.

There are different types of databases such as plain, relational, network, hierarchical, object, etc. A plain database (also called flat database) is storehouse of data without inherent tie among files or tables. Each file or table is separate and independent. AutoCAD files and Spreadsheet files like those of Microsoft Excel are examples. Relational database is a database with some kind of relationship or link between structured tables. Each table is made up of one or more records. A record is a set of data that describes a unit of information about an item or object. Microsoft Access is an example of a relational database. Network databases represent data as records at two main levels of record type and recordset. The record type is generic while the recordset has a-one-to many type of relationship with other records. Hierarchical databases represent data in a treelike structure with each level containing a number of related records. The folder or directory structure is a good illustration of a hierarchical database. An object-oriented database stores data as objects. Data structure, values and actions can be stored in an object database. It is a sophisticated database.

PDMS
PDMS stands for Plant Design Management System, a 3D process plant modeling software from AVEVA Group Plc. It has applications and reference data for every engineering discipline in design such as Equipment, Pipework, Structures, HVAC, etc. Graphics are produced from a single coherent data model for an entire plant. Reports from PDMS are available in the form of text, 3D illustration graphics and 2D dimensioned drawings. It was first launched in 1976 and has backward compatibility with earlier versions and some other leading industry products. The current version is PDMS 11.6 but we are operating version 11.5 in this training.

PDMS Database Sets
The structure of PDMS database is hierarchical. There are two sets of databases in PDMS. These are Design and Reference databases. Design stores user’s generated data and information. A design project may have multiple databases based on discipline. PDMS design databases contain 3D model data and information. References database stores read-only data and information. Data and information from these databases are pulled into design databases. The data in the reference databases can not be modified by the user.
**PDMS Database Hierarchy**

PDMS database is hierarchical, that means lower level data are contained in upper level data. Imagine the database to be a data space divided into sections. Smaller sections are contained in bigger sections. The smaller the section is, the farther it is from the base or root data space as shown in Fig. 1. The root data space is the “World”. The “World” data space is divided into “Site” data spaces. A “Site” data space can be divided into “Zone” data spaces. A “Zone” data space can be divided into smaller data spaces as needed by a project, often along the collaborating disciplines for the project. The “World”, “Site” and “Zone” data spaces are common to all collaborating disciplines. The “World” data space is fixed. It is populated by creating “Site”, “Zone” and lower data spaces. You must be at the “World” level to be able to create a “Site” data space. Similarly, you must be at the “Site” level to be able to create a “Zone” data space. During design modeling, the data representing and describing the model are stored at the appropriate level in the database.

![Fig. 1 PDMS Design Database Hierarchy](image)

![Fig. 2 Layout of PDMS Database](image)
Osakue E.

Fig. 2 shows a simplified layout view of PDMS database. It is clear from this figure that the “World” data space contains all data in the different sections or levels. The user does not create the “World” data space, it is the default data space once PDMS is installed and configured. It is the top-level element in PDMS database and cannot be deleted by the user. The user creates a “Site”, “Zone”, etc as necessary for a project. Typically, the name of “Site” would be the project name or the user name. Sometimes, it may be the name of a portion of a large project. A “Site” is not necessarily a physical area or job site. Similarly, a “Zone” is just a collection of similar or related items for easy reference. Since PDMS Design modules has applications for different design disciplines such as Equipment, Pipework, Structures, HVAC, etc, a zone may be named as one of the disciplines in a project. Note that if a “Site” is deleted in the database, all the zones contained in it will be lost! It is safer to work at the lowest level to avoid unwanted loss of data.

The Design module of PDMS is used to build a 3D plant model whose data may be stored in one or more databases. It can be used to create new design elements, modify existing design elements, query and interactively view design elements, creates reports and check for clashes. Components can be selected from one or more reference databases and inserted in a required position during a design project.

Primitives
Primitives are the basic building blocks in PDMS. They define basic solids that can be combined to create equipment. Primitives are used by all disciplines. PDMS primitives include Nozzle, Cylinder, Box, Sphere, Torus, Pyramid, etc. When primitives are combined, they are not fused together; they remain separate elements but flushed with each other. The technique of using primitives to construct solid models is known as Constructive Solid Geometry (CSG). In PDMS an element may be a primitive, component, or device. Each element has features and functions that are associated with attributes.

Attributes
Objects in PDMS have attributes. Attributes are characteristic features of objects that are used to define and describe them. There are some common attributes among different objects, but each object has a fixed set of attributes. These attributes may be grouped as administrative and geometric. Administrative attributes help to identify and describe the object while geometric attributes are used to define the geometry and spatial relations of the object. For example, some of the administrative and geometric attributes of a cylinder are:

<table>
<thead>
<tr>
<th>Administrative Attributes</th>
<th>Geometric Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: Primitive (Hierarchy level name)</td>
<td>Diameter:</td>
</tr>
<tr>
<td>Type: CYLI (Cylinder)</td>
<td>Height:</td>
</tr>
<tr>
<td>Lock: True/False (Allows or disallows editing)</td>
<td>Position: Coordinates of origin</td>
</tr>
<tr>
<td>Owner: Parent’s Name (e.g. Pump)</td>
<td>Orientation: Angular direction</td>
</tr>
<tr>
<td>Level: 0-10 (Visibility level)</td>
<td>Origin: a reference point in an object</td>
</tr>
<tr>
<td>Obstruction: 2 (Clash type)</td>
<td></td>
</tr>
</tbody>
</table>

Remember that the above listing of attributes of a cylinder is incomplete. During design, values are assigned to these attributes. Default values are retained if new values are not provided. Zero values are unacceptable for some of these attributes. For a box, the geometric attributes will be length, width and height, in addition to the position and orientation attributes. The administrative attributes of name and type will be primitive and box, respectively. It is also important to realize that 3D CAD databases have topological attributes that are used for validity checks of solid surfaces. Examples of such attributes are vertices, edges, and faces. Rules are used to ensure that valid combinations of these attributes exit for the proper definition of a solid. The elements in the reference databases have attributes too.

The name attribute is very important for element identification and reporting. Each element in PDMS database has a unique name. Give names that are meaningful.

The obstruction attribute defines the severity of clash between elements. It can be set to hard (2), soft (1) and none (0). Hard obstruction means the element volume is hard and impenetrable e.g. beams, vessels, etc. Soft obstruction means the element volume is penetrable but must be kept clear for access. If no danger to human and/or damage to equipment is likely in a clash or interference, the obstruction attribute is not necessary. Clashes are ignored when obstruction value is 0 or none. Obstruction values should be set for all elements to ensure proper space management.
Osakue E.

Some elements, especially in piping, need some sort of insulation. This requires additional volume, so it is referred to as insulation volume and it is seen as an obstruction type. Maintenance and access areas are other sources of extra volume that must be accommodated during design.

The level attribute is used to represent the amount of detail displayed in an element. Simple representation has values in the range of 0 – 3 while detail representation range is 4 – 10, inclusive.

Generally, obstruction and level attributes should be set jointly. Predefined settings are:

- **Detail w/ obstruction:** Obs. = 2; Lev = 2-10
- **Obstruction volume:** Obs. = 2; Lev. = 9-10
- **Insulation volume:** Obs. = 1; Lev. = 7 – 10
- **Reserved volume:** Obs. = 1; Lev. = 8 – 10
- **No obstruction:** Obs. = 0; Lev. = 2 - 10

**Main Design View**

Fig. 4 is the main graphic view. Take some time to familiarize yourself with the menu items and options in this view. The Design menu provides access to different design disciplines. The title bar of the form displays the current application selection. The default application from this menu is General Application as can be seen in Fig. 4 (the drawing shown is a plan view of a project in development). Design activities are done in the work area (black background, it can be changed to white). The Display menu offers options on what graphic models may be shown on the screen. The Edit menu provides access to modification options on models. The View menu offers options on how graphic models may be shown on the screen, etc.

![Main Design View](image)

*Fig. 3 Main graphic view*
Database Navigation

The PDMS database can be navigated with the aid of the Design Explorer and or the Members forms. The Design Explorer is a graphic-based form that provides access to all the model elements in the database. It is similar to the Windows Explorer. The Members List is a text-based form and like the Design Explorer, it provides access to all the model elements in the database. The Members List is accessed from the main menu:

Display > Members

Elements in a “Zone” are said to be owned by the zone. For example, an equipment like a pump unit created in a zone, is owned by that zone, that is, the zone is the owner. Selecting a zone means all the elements in it are automatically selected. The selected item is referred as the Current Element (CE). The CE is the active element that can be modified.